
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

An Introduction to 
Sports Scheduling with Diamond Scheduler 

 
 

© 2002-2009 John R. Hall 
 

Publication Version: November, 2009 
 



- 2 - 
 

Table of Contents 
 

 

Diamond Scheduler Sports Scheduler Software............................................ 3 

Types of Scheduling..................................................................................... 3 

How to use this Introduction ......................................................................... 3 

Creating a Schedule: A tutorial..................................................................... 4 

What You Need First .................................................................................... 4 

Creating the Round-robin Schedule................................................................ 4 
1.   Load the program ............................................................................... 4 
2.   See where we’re going by looking at a completed schedule ....................... 4 
3.   Create a new schedule file.................................................................... 5 
4.   Create the division name ..................................................................... 6 
5.   Create the team names ....................................................................... 6 
6.  Create the field names.......................................................................... 8 
7.  Create timeslots .................................................................................. 9 
8.  Choose a scheduling method ................................................................13 
9.  Schedule the teams.............................................................................15 
10.  Looking at Available Reports ...............................................................15 
11. Printing a Report................................................................................17 
12. Looking at the Master Calendar ............................................................18 

Frequently Asked Questions for Diamond Scheduler .................................. 22 

Multiple Copies of the Program.....................................................................22 

Copying the Program to Disk........................................................................22 

Custom HTML Codes ...................................................................................22 

Can not Schedule All the Games ...................................................................22 

Scheduling Multiple Divisions .......................................................................23 

Across-division (or league) Schedules ...........................................................25 

Across-Division Schedules with Many Divisions ...............................................27 

Some Final Words ...................................................................................... 28 



- 3 - 
 

Diamond Scheduler Sports Scheduler Software 
 
Welcome to Diamond Scheduler Sports Scheduling Software. This overview will 
provide you with the introductory information you need to successfully schedule 
most sports leagues.  

Types of Scheduling 
You have probably heard of many types of scheduling - round robin, elimination, pool 
play, and guaranteed-play. Diamond Scheduler can be used to support several types 
of scheduling tasks. Its strength is round-robin scheduling with the ability to control 
several constraints.  
 
Round-robin scheduling implies that for each “round,” each team plays every other 
team once. So, if you have 4 teams, each team will have 3 games per round since 
there are 3 teams each one can play. In short, for every round of play, each team 
will have n -1 games, where n is the number of teams. 
 
Creating round-robin schedules for 4 or 5 teams is quite simple to do by hand. 
However, when you start dealing with a large number of teams or when you want to 
control some factors like which days certain teams can not play, a computer-based 
scheduling program like Diamond Scheduler comes in handy. 

How to use this Introduction 

This introduction to using Diamond Scheduler employs a tutorial approach. Follow 
the steps of creating a sample schedule and you will learn the basics of scheduling. 
 
You may find it more interesting or engaging to watch a video that introduces the 
basics of scheduling in a similar manner. You can find those movies at my web site: 
http://www.cactusware.com/movies. 
 
Let’s get started. 
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Creating a Schedule: A tutorial 

What You Need First 
Before you can begin scheduling, you need to gather a few pieces of information.  
 
You will need the following: 
 
1. The name of the division (or level - e.g., Major Softball) 
2. The names of the teams (or players if it’s an individual sport) 
3. The names of the venues (fields or courts or ice rinks) 
4. The times that each venue is available 
 
If you are working with an individual sport (e.g., darts), substitute the term “person” 
for “team;” it will work fine. If you work with “courts” or “rinks” instead of fields, 
substitute those names where appropriate.  
 
Tip: If you want to change the labels on the tabs for Diamond Scheduler, hold down 
the shift key while clicking on the tab’s label. For instance, if you use “rinks” instead 
of “fields,” hold down the shift key and click on the label “Fields/Courts” on the third 
tab, then follow the directions. 
 
Once you have gathered all the information above, you are ready to begin your 
schedule.  

Creating the Round-robin Schedule 

For now, I’ll keep things pretty simple. However, along the way, I’ll talk about more 
advanced features and their use. 
 
(Note: The sample below details a round-robin league schedule. However, the 
process for creating an elimination tournament is the same until you click on the 
scheduling method.) 

1.   Load the program 

Assuming you loaded the program onto your computer, start Diamond Scheduler by 
doing the following: 
 
 Click on the Start button at the bottom left of your computer. 
 Click on All Programs. 
 Click on Diamond Scheduler. 
 Click on the icon for the program. 
 
I hope that went well. I wanted to give you something easy to start with ... a real 
confidence-booster. 

2.   See where we’re going by looking at a completed schedule 

One important principle to understand is that in Diamond Scheduler, you schedule 
one division at a time. Each division is a separate file. Once you have completed all 
divisions, you can merge them into a Combined Schedule Report (by choosing File > 
Merge Schedule Files) that will display the global schedule and calendar. 
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In this tutorial, I'm going to walk through a tutorial that represents one division of a 
league. Before we actually create that file, I’d like you to take a quick look at a file 
that is similar, although not exactly the same, so that you can get a feel for how the 
program works: 
 
 Click on the File menu. 
 Click on the Open menu. 
 Load sample.shd, which should be in the My Documents\Schedules directory, 

unless you chose to install the program in a different location. 
 
You will see that the file is for a Softball Seniors division (click on the Division/Level 
tab and note that Softball Seniors is the division), with 5 teams (click on the 
Team/Players tab), using one field (click on the Fields/Court tab).  
 
I also know that this one field has 65 available playing times - what I call timeslots in 
Diamond Scheduler. I know that for two reasons: 1) I created the schedule and I 
know how many timeslots I identified (authoring the program has real advantages 
when it comes to writing the manual) and 2) I can go to the Tools menu and choose 
Timeslot Calculator, which will tell me the total number of times available across all 
fields. Since I only have one field in this file, I know all 65 timeslots are associated 
with this one field. 
 
I also know, by looking midway down the field tab information, that all 5 teams can 
use this field as their home field – in other words, they can all play home games 
here.  
 
You now have all the information you need to create the schedule.  
 
 Click on the Schedule tab. 
 Click on the Optimized button near the top right (this is the most frequently used 

pairing algorithm – you can look around the options a little if you like but we’ll 
come back to these later). 

 Click on the Schedule It Now button at the bottom right of the screen. You should 
see a gauge reflecting the progress of the schedule’s creation. 

 
Once the schedule is complete, you can a) click on the Master Calendar button to 
view the calendar or b) click on the Reports button to explore the available reports.  
 
My goal now is to get you to create a very similar schedule, understanding the 
scheduling issues in a bit more depth as we go along. In addition, we’ll create one 
that uses two fields so that you can see how that works. 

3.   Create a new schedule file 
We’ll start from scratch so you get plenty of practice creating a sample schedule.  
 
 Click on the menu item at the top that says File. 
 Click on “New”  (if the program asks if you want to save changes say, “No”). 
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We’re starting a new file. All the information you saw before should be gone and you 
should have a blank schedule. 

 

 
Reminder about the Tabs - you can change the labels by holding down the shift key 
while you click on any of the labels. 

4.   Create the division name  

 Click on the Divisions/Level tab. If you’re not already on the tab, click on the 
label that says “Division/Level.” 
 

 Click on the "+" button at the bottom right of the tab. The program asks for a 
name to give the division. Input Softball Seniors (if you would like to start 
creating your own file, go ahead and put in the name of your first division). 

 
Tip: If you can keep the division name fairly short and descriptive, it will make for 
less verbose reports later on.  
 
If you have any general notes regarding this division, you can type them into the 
Notes field.  

5.   Create the team names 
 Click on the Teams/Players tab. Here's where you enter all the teams in the 

division.  
 Click on the "+" button to create your first team. 
 Provide a short name of the team, avoiding punctuation like periods and commas 

and other symbols that will make later reports look a bit messy. Name the first 
team: 
 
Burbs 1 
 

 Next you need to provide the program with a code for Burbs 1 (up to 5 letters), 
use: 
 
B1 
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Tip: Although the code can be used on printouts, its main function is for the 
program to use internally to keep track of teams. It is quite important that you 
give this team a unique code, even if it’s simply a number code like 01 or 23. 
Even more importantly, make the code unique across your entire league. In other 
words, don’t use B1 here and then use B1 in another file for another division to 
refer to a different team.  
 
Basic principle: Name your teams uniquely across divisions and use unique codes 
across divisions so that when you merge all the files, there’s no chance that a 
team from one division can be mistaken for a team from another division. 
 

 Add whatever additional information you have or want to track for the Coach 
(you can store information on two coaches).  

 At the bottom of the form, give this team a unique Custom HTML Code. This is a 
code that can be used on HTML exports instead of the regular code.  This allows 
you to use a different abbreviation upon export to HTML, if that’s useful to you. 
However, the longer this abbreviation, the more crowded calendar displays will 
appear.   
 
For this sample, I’ll give Burbs 1 the Custom HTML Code of: 
 
Brb1 
 

 Repeat this process for 4 more teams. 
 
 
You already have: 
 

Team Code Custom HTML Code 
Burbs 1 B1 Brb1 

 
 Now add:  
 

Team Code Custom HTML Code 
Burbs 2 B2 Brb2 
Central 1 C1 Cntr1 
Central 2 C2 Cntr2 
Mavericks MV Mavs 

 
Some advanced tips for creating teams: 
 

1. Use the No-play times to prevent a team from being double booked if they’re 
already scheduled in another file. When you click on the No-play Times 
button, you’ll be given the opportunity to base no-play times for the current 
on one team from another schedule or base no-play times for all teams on 
another schedule’s already determined timeslots. 

2. Use the No-play field only if it’s really necessary to solve a problem. Same 
with no-play teams – the latter is best use to avoid a match between teams 
that have fights. 

3. Use the Import Teams to import information about all the teams from a 
previously made schedule. 
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Tip: You can use advanced tip number 1 above to make sure a coach who 
participates in two divisions is not double booked. Schedule the first division in which 
s/he coaches, then when creating the second division, click on the No-play Times 
button and base the no-play times on the team s/he coaches in the first division. 
 

6.  Create the field names 
Once you're done entering all the teams, it's time to identify all the fields where the 
teams can play. You may be using “courts” or “rinks” - that’s fine. In the sample file, 
I’ll be using baseball fields.  
 
To demonstrate how teams can have a specific home field, I will create two fields.  
 
 Click on the Fields/Courts tab.  
 Click on the "+" button.  
 Provide a name of the field, avoiding punctuation like periods and commas and 

other symbols that will make later reports look a bit messy. I name the first field  
 
Central Field 
 
When asked, provide the program with a code for Central Field. I use: 
 
CF 
 
Tip: If you are going to refer to this field in another schedule (i.e., another 
division for the same league), be sure to use the exact same spelling of the name 
and code so that the program recognizes the two fields to be the same when the 
schedules are merged. You can ensure that the spelling is exactly the same in the 
next file by using the Import Fields button on the field tab of that file. 
 

After identifying the field name and code, you must tell Diamond Scheduler which 
teams can use the field as a home field. If all teams in your league can play a home 
game at this venue, click on the small button on the right side that says “All” and all 
teams will be added into the Home Teams area. If all teams can use all fields at your 
site, be sure to click “All” for each of the fields. 
 
In this tutorial, we want only the two Central teams to use this as a home field.  
 
 Click on the small button on the right that says “Set” (meaning set the home 

teams for this field). 
 Highlight the two Central teams (Central 1 and Central 2) in the multi-select list 

box that appears. 
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Adding home teams to a venue. Click on the Set button, then highlight 
the teams that can use this field as a “home field” 

 
(Note: Instead of “Home Teams,” selection would best be named “Teams that are 
allowed to use this field as a home field, even if they use other fields also,” or so I’ve 
been told. Unfortunately, there’s not enough space on the screen to make that clear 
so the section simply says, “Home Teams.”) 
 
 Click on the Done button above the list box. 

 
So far, you have created the field and you’ve identified the two teams that can use 
this field as their “home field.”  
 
However, Diamond Scheduler doesn’t know when those teams can use this field as 
their home field. To identify those times, we create what I call “timeslots.” 

7.  Create timeslots  
 
Click on the button that says Create Timeslots. You will be presented with a calendar 
display like the one below (without all the explanatory labels and a different color 
now, but the concept remains the same). 
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There are many ways to enter timeslots. Try each of the following methods to 
become familiar with the technique. 
 
 Left click on a day on the calendar. You will notice a blue highlight around the 

day. 
 Press the enter key. 
 When it asks what time the field is available, type in 

 
5PM 
 
You could have also typed: 
 
1700 
17:00 
5:00P 
5P 
 
All would have been interpreted as 5PM. However, if you had only typed 5:00, 
that would have been interpreted as 5AM. To create a week of 5 o’clock games, 
you could copy the day to each of the remaining days by using any of the 
following methods: 

 
Method 1 
 Left click on the next day that should have a 5 o’clock game. 
 Press the Enter key. 
 Press the Enter key. 
 Repeat for as many days as you like. 
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This method works fine if you only have one timeslot. If you have many timeslots 
per day, the following method is more efficient: 
 
Method 2 
 Right click on the day for which you just entered a time. 
 Click on Copy Day as Template. 
 Right click on a different day. 
 Click on Paste Template Day. 
 
As you can see, you can quickly copy a whole day’s games to repeat on another day. 
If you examine the right click menu, you’ll also note that once you have a whole 
week’s pattern created, you can copy and paste weeks. Entering timeslots can go 
quite quickly this way. 
 
Once you have a week of games created, you can use it as pattern for a weekly 
template. You would  
 
 Right click on a Sunday of the sample week, choose Copy Week as Template. 
 Right click on the Sunday of a week to which you want to copy the week and 

choose Paste Week from Template. 
 
You could, alternatively, right click anywhere on the calendar and choose Paste Week 
until Specific Date, which will paste the template week until the date you specify on 
the calendar that pops up. 
 
All of these options make creating the timeslots easy.  
 
 
Method 3 
Let’s say instead that you play every weekday of the month at 5PM on this field. At 
the lower right of the timeslot calendar, you’ll see a form entitled Recurring Timeslot.  
 
 Type 5PM in the text field of the Recurring Timeslot form. 
 Click on the box in front of each weekday. 
 Click on the Add It button. 
 
Quickly, a 5PM timeslot is added for all days of the month.  
 
For the sake of our tutorial, please …. 
 
 Delete all the timeslots you just created by clicking on the button that says Clear 

All Timeslots for this Location. 
 
Once all the timeslots you practiced creating above are erased, do the following: 
 
 Using whatever method you like, add seven weeks of weekday-only games at 

5PM for Central Field. 
 On one day within those 7 weeks, delete the timeslot (right click and choose 

DELETE entire day). It doesn’t matter for the tutorial which day you choose. If 
there isn’t a real holiday during that time, pretend that one of the days is a 
holiday and avoid identifying timeslots for it since this is exactly how you would 
take care of a typical no-play day: You simply don’t provide the program with a 
timeslot on that day. 
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OK, do you have seven weeks of timeslots? If so, 
 
 Click the Close Calendar button at the bottom right of the timeslot calendar. 
 Click on the Tools menu at the top of the screen. 
 Click on Calculate Identified Timeslots. It should say 34 if you have seven weeks 

of games with one day off for a holiday. If not, go through this process again and 
pay careful attention to the directions. 

 
OK, we have our first field done. Central Field is identified. It is used by the two 
Central teams and it has seven weeks of timeslots (with one day off for a holiday).  
 
We need our other field for our other teams. That field is called the Outerbanks Rec 
Center. 
 
 Click on the "+" button.  
 Provide the name of the field: 

 
Outerbanks Rec Center 
 

 When asked, provide the program with a code for the field (up to 5 letters), use: 
 
O1 
 

Three teams are going to use the Outerbanks field as a home field: the two Burbs 
teams and the Mavs. 
 
 Click on the small button on the right that says “Set.”  
 Highlight the two Burbs teams (Burbs 1 and Burbs 2) plus the Mavericks. 
 Click the Done button. 
 
So now we have the new field identified and we’ve indicated which teams can use 
this field as a home field. It’s time, once again, to identify the timeslots for this field. 
 
Let’s assume that this field is available exactly the same times that the Central Field 
is available. Rather than spend the time needed to recreate the timeslots for the 
Central Field, we’ll copy them from Central Field. 
 
 Click on the button that says Import Timeslots. 
 Choose This File (as you can see, you could import timeslots for another schedule 

file if you wanted). 
 
Tip: If you have all the timeslots you want in another schedule file and you can 
click on this button to import all field information and all timeslots from another 
file. In this case, we’re just copying timeslots from one field. However, keep this 
hint in mind if you have, let’s say, ten fields with timeslot info in another 
schedule file. In this case, you would NOT create the fields here; you would 
import all the field info at one time from the other field before you ever click on a 
pencil icon of the fields/courts tab. 
 

 Choose Central Field (in other words, we want to copy all the timeslots that exist 
for Central Field). If we already had some timeslots for the Outerbanks field, you 
would be asked if you wanted to Add to the existing timeslots or Replace the 
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existing timeslots. Since we have not created any timeslots for the Outerbanks 
field, the timeslots are copied without posing that question. 

 Click on the Tools menu and choose Calculate Identified Timeslots (you should 
now have 68 timeslots identified). 

 
We are about ready to go. We could try to schedule the teams right now, but you 
would be presented with a dialog box telling you that you must save the file before 
you can schedule the teams. So let’s save the file and avoid the message box. 
 
 Click on the File menu. 
 Choose SaveAs. 
 Use the name tutorial (the program will automatically append an *.shd file 

extension to the file - you do not have to do that manually). 
 Click OK. 
 
Some advanced tips for field and timeslots: 
 

1. Use the Exclude Timeslots button to make sure you haven’t double booked 
timeslots. This button will allow you to check another file/s and make sure the 
same timeslots are not repeated in the current file. 

2. Use the Import Timeslots to copy all the timeslots from one field to another or 
to bring in timeslots for another file. If you have no fields created in the 
current file when you click on this, this button will allow you to bring in all 
timeslots from another schedule or from a leftover file. 

3. The Import Fields button at the top right allows you to bring in information 
about fields without timeslots from another field. 

8.  Choose a scheduling method 

We are about to schedule the teams for the season. To demonstrate a couple of 
features of the program, I’ve intentionally set you up for a little failure. Namely, we 
have 34 timeslots for two teams on one field and 34 timeslots for 3 teams on 
another field. Our field that hosts 3 teams is going to come up short by a couple 
timeslots. At that point, we’ll be given the opportunity to allow those teams to play a 
home game on the Central Field using some of its leftover timeslots. I warn you 
solely so you don’t think you did something wrong.  
 
OK. Let’s schedule. 
 
 Click on the Schedule tab. 
 
You can see that you have many choices of pairing methods. At the upper left you 
have two elimination methods that can be used for end-of-season tournaments or 
playoffs.  On the right side, you have six different methods: 
 
Optimized Method works for 2 - 30 teams using a pairing system that attempts to 
distribute the schedule such that all teams play each other once before playing 
another team again. Whether this can be accomplished is dependent upon the 
availability of home field timeslots, but the method is usually very good at finding a 
solution. This is the pairing algorithm that is best to use in your first attempt, as it 
provides a good balance of many scheduling variables. 
 
Available Timeslots also works for 2 - 30 teams and attempts to schedule games 
until all timeslots are used. This method doesn’t care if you schedule an exact 
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number of rounds or even if all teams have the same number of games. It is the 
same as the Optimized method except it just keeps scheduling until all timeslots are 
gone.  
 
Randomize Pairings creates a different pairing each time you use it; the pairing is 
random. When you click on this option, you will be asked if you want to force an 
equal number of games for all teams. While this algorithm has been included by 
request, the Optimized pairings will always provide the best balance of home/away 
games without odd runs of home or away pairings.  
 
Import Pairings allows you to edit your own pairings and import them into 
Diamond Scheduler. While this feature is not generally recommended, the facility has 
been created in case you already have your own system of matching teams. The 
format in which the pairings must exist is two comma-delimited lists with spaces 
between team numbers. If you are interested in importing pairings, take the time to 
read more about this method in the help file (go to the Help menu and choose 
Contents, then search for Import Pairings). 
 
The Practice Schedule uses the identified timeslots for all fields as practice time. In 
other words, only one team is scheduled per timeslot.  
 
Tip: It’s quite common to create a practice schedule before the season starts in one 
schedule file, then create the regular season league play in another file, then merge 
the two files to create the combined total schedule.   
 
The Manual Entry button of the schedule tab allows you to insert all timeslots into a 
finished calendar, without particular teams associated with those timeslots. You can 
then manually edit particular match ups (say the final game or opening game 
between two competitive teams), lock those games (right click on the game and 
choose "lock"), then unlock the schedule. You will be asked if you want to save the 
games you have locked. Then, when you create the automated schedule, you will be 
queried as to whether you want to insert the games you had originally locked. 
Answer "yes" and you've got a solid schedule with particular games inserted where 
you want. 
 
The Youth Baseball pairing method works for 4 - 10 teams, with 4 teams having a 
choice between an 8-week or 9-week schedule. The algorithm used with this pairing 
is similar to that suggested by the most popular youth baseball organization whose 
initials are LL .  
 
The Cyclic Foursomes method is a special pairing of pairs. Commonly used in 
doubles tennis, Bridge or informal golf tournaments, this method identifies unique 
pairs of pairs for a season whereby each player is paired with every other player 
once and opposes every other player twice. This method is not commonly used but 
sure is handy if you’re trying to set up a tournament to accomplish such social 
pairings. 
 
For our tutorial, we will use the Optimized method of schedule. So: 
 
 Click on the Optimized button. 



- 15 - 
 

9.  Schedule the teams 

There’s a lot of information on this screen. Eventually, you should know what all the 
features can accomplish since various combinations of the buttons can help you solve 
difficult problems with scheduling.  
 
To introduce you to what each button does, take the time now to sequentially right-
click on each label on this screen to get more information about all the options. 
 
Did you really take the time to right click on everything? It can save you a lot of time 
in the future if you understand what each button does. (And it can save me technical 
support!) 
 
OK, for our tutorial, we’re going to do a very simple schedule. A round robin, where 
teams can play two nights in a row, if need be, with normal pairings (not back-to-
back). 
 
 Make sure Normal Pairings is marked at the upper left. 
 Make sure all other boxes on the left side are empty - no checkmarks. 
 At the upper right, click on “Next Day OK,” which means a team can play another 

game the next day, although this shouldn’t happen too often (Note: because I’ve 
intentionally built in problems to demonstrate two-pass scheduling, having one 
Day’s rest would make the schedule even more difficult. If you want to 
experiment with a file in which you can use one day’s rest, see the sample file 
included with the program: sample.shd.). 

 In the number of rounds, 6 rounds should be suggested. No need to change that; 
the program is pretty good about suggesting the correct number of rounds based 
on the number of timeslots you have identified. As you become more advanced, 
you’ll want to be able to calculate rounds and timeslots need for a specific 
number of games. Although you don’t need to worry about that right now, that’s 
why the calculator button is there. 

 Click on the Schedule It Now button. 
 
If everything goes as planned, you will come up two games short. That’s because we 
didn’t give the Outerbanks field quite enough timeslots to support 3 home teams.  
 
Fortunately, Central has several leftover timeslots and the program is now asking 
you if you want to do a second pass on the schedule attempt without worrying about 
where those final two games are played. In other words, will it be OK for the Burbs 
1, Burbs 2, or Mavs to play a home game at the Central field just to finish up these 
last two needed games. 
 
Let’s pretend that doing so is not a political problem and say, “Yes”: 
 
 Click on the button that says “Ignore Home Fields.” 
 
Your final two games should be scheduled and you should be notified that your 
schedule is complete. 

10.  Looking at Available Reports 

Assuming that you’re on the schedule tab, you’ll see three buttons now that the 
schedule is created: Master Calendar, Reports, and Unlock Schedule. 
 



- 16 - 
 

Master Calendar takes you to a calendar view of the scheduled games. We’ll take a 
look at this view of the schedule in a little while.  
 
The Reports button will allow you to see three different kinds of reports. We’ll take a 
look at those reports in just a minute.  
 
Finally, the Unlock Schedule allows you to start over on the schedule creation 
process. 
 

 Click on the Reports button. 
 
You should now be seeing the reports form, looking first at the Teams report. You 
can tell it’s the Team report because it says so in the upper left corner of the screen, 
plus the Teams button at the upper right is disabled. 
 
As you’ll notice at the bottom right of the screen, you can choose a team you care to 
analyze.  
 
At the left, near the bottom, is a button with the caption of Game Balance Sheet.  
 

 Click on the Game Balance Sheet button. When asked, choose View so that 
you can view the distribution of games by team across the days of the week 
(though the display is now a dark gray). 

 

 
 
As you can see, in our schedule, we have a pretty good balance. Each team has 12 
home games and 12 visitor games. There’s some disparity on the Wednesday night 
games (Burbs 1 only plays twice on that night), but otherwise the schedule is pretty 
well balanced. 
 
For our purposes, we’ll say this basic schedule is just fine. We’ll pretend like we don’t 
have a bunch of parents who whine about exact distributions of the days of the week 
(though we can address that issue later – see help file for more detail on using Days 
of the Week balancing).  
 

 Click on the Close button to close the Game Balance Sheet. 
 Next to the Game Balance Sheet button, click on the button that says Games 

by Team Frequencies. 
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As you can see, this allows you to see how many times each team plays every other 
team. In the case of an even round robin, the answer is, by definition, the number of 
rounds you input earlier. This button will become more useful when you’re doing 
complex schedules that do not involve an even number of rounds. 
 

 Close the Games by Team Frequencies dialog box by clicking on the Close 
button. 

 
At the top of the reports screen, you will see three buttons that allow you to view the 
games by teams, fields, or division. Click on each to see what type of information is 
available.  
 

 Return to the Team report tab by clicking on the Team button at the upper 
right. 

 Click on the List button under the View area on the right side. This represents 
another view of the same information for this team. 

 Click on the Calendar button under the View area and note the team’s play 
dates in calendar form.  

 Click on the Done button to return to the Reports area. 
 

11. Printing a Report 

(Note: Printing and Exporting information will only work in the registered version of 
the program).  
 
You should be back at the Report area for teams. At the bottom, you’ll see the name 
of the team you’re currently examining.  
 

 If you are not already in Cell mode, click on the Cells button on the right side 
in the View area. 

 
Let’s assume that you want to print out this information. You can, if you like, print 
out a rough report within Diamond Scheduler. If you are linked to a printer, click on 
the Print button at the bottom of the screen.  
 
You should have a text-based printout of the current view.  
 
However, throughout the program, you can create much nicer reports if you choose 
to Export to HTML. If you have Microsoft® Excel on your computer or any browser, 
Diamond Scheduler will prompt you to see if you want to open exported reports. If 
you want to do additional editing on the export, open the file in Excel as it turns out 
to be a very nice application in which to edit Diamond Scheduler’s HTML.  
 
If you have Excel on your computer and you’re a registered owner (Diamond 
Scheduler won’t export in the demo version), try the following: 
 

 Click on the button on the right side that says As HTML.  
 Accept the defaults for information to include when the dialog box appears by 

clicking on the OK button. 
 When asked whether you want to create a report for this team or all teams, 

choose This Team for right now. 
 Give the file a name … it can be “temp” or some other name. 
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 If this is the first time you’ve exported to HTML, you will be asked if you want 
the program to prompt you for opening the exported report in Excel. If you 
have Excel on your computer, answer, “Yes.” 

 When asked if you want to open the file in Excel, say “Yes,” if you have Excel, 
or choose “Browser” if you don’t have Excel installed. 

 
The spreadsheet should look something like the picture below. 
 

 
 
The dates you have will likely be different than the picture. 
 
Opening the file in Excel to do final editing allows you to sort the information in 
different ways, change the colors if you don’t like the defaults, and, in general, just 
enjoy more control over the final output. Since this is HTML code, you can edit it 
using any HTML editor or post the file to a Web site. 
 
All reports in Diamond Scheduler can be exported to HTML and opened in Excel or a 
Web browser. 
 

 Close Excel. 
 Back in Diamond Scheduler, click on the Done button at the bottom right of 

the screen to return to the schedule tab and the three large buttons. 

12. Looking at the Master Calendar 
You should now have a feel for the type of reports you have available to you.  
 
Let’s now take a look at the Master Calendar. 
 

 Click on the Master Calendar button. 
 
As you can see, the games that have been schedule are displayed in calendar 
format.  
 

 Left click one of the days that has games. You will see a dialog box appear 
with details about the day’s games. You can also turn on the flag near the 
center of the bottom that says, “Pop Up Day Schedules on Mouse Point.” That 
will automatically display an expanded version of the games when you roll 
your mouse over the day on the calendar. 
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 Close that dialog box by clicking on the Close button. 
 
That’s how you can see detail on any given day’s game. Still, there are several 
features hidden in the Master Calendar.  
 
One of the first things you'll notice when you go to the Master Calendar is the 
Options Tab at the upper left of the screen. Clicking on the Options label of that tab 
reveals three calendar display options: 
 
Show Open Timeslots - display those timeslots that still exist at the various venues, 
but which were not taken during the scheduling process. 
 
Flag Field Conflicts - checking this box will highlight any days that games occur on 
any one field sooner than the specified window of time. 
 
Flag Multiple Game Days for Teams - checking this box will highlight any days where 
the same team has more than one game (to avoid inadvertent scheduling of teams 
for more than one game per day). 
 

 Right click on a day with games. 
 
This menu allows you to do many things with the schedule to modify and enhance 
the automated scheduling results. This menu is your key to doing many things 
including switching games around, flipping home and away, locking certain games so 
that you can unlock the full schedule while keeping certain games “hard-wired” into 
the schedule, and a variety of other tasks. 
 
Let’s take a look at some of the options on the next page. While I have not yet had 
time to change the graphic, you’ll see most of the same menu items but in a slightly 
different order. The functions remain the same, and a few have been added. 
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Some of the things you can do: 
 Limit the teams which are 

displayed on the Master Calendar 
 Edit game times and teams 
 Add a game manually 
 Cut a game  
 Copy a game 
 Paste a game 
 Move a whole day's schedule  
 Move whole schedule up a week 

or a year 
 Switch around who is home team 

and away team 
 Switch home and away on all 

games 
 Switch home and away only on 

unlocked games 
 Switch a Monday pairing with a 

Friday one 
 Delete pairing but not the timeslot 
 Edit the umpires for the game 
 Record who won the game 
 Lock games even if you unlock the 

schedule so you can “hard-wire” a 
game between certain opponents 
on specific days 

 
 
 Dismiss the menu by pressing the escape key. 
 Using the arrows at the top of the Master Calendar, go to the last month of your 

schedule (in my case it’s June because I started my seven-week schedule in 
May). 

 
You should see several timeslots with displays that have two asterisks playing two 
asterisks. This implies that this is still an open timeslot that can be used for rainouts 
or other postponements. You can either show or hide open timeslots using the 
Options tab at the top left of the Master Calendar. 
 
When we first made the schedule, I asked you to leave one day open representing a 
holiday. Let’s say that for some reason, you now need to move the games from one 
day earlier in the season to that date. 
 
 Right click on the date that had a rainout. 
 Choose Move This Day. 
 Right click on the date to which all the games should be moved. 
 
That’s how you can quickly move an entire day’s games 
 
OK. That’s the basics of making a schedule.  
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If you want to see what the calendar view can look like printed, you can click on the 
Print button at the bottom of the screen.  
 
A nicer printed report can be created if you use Excel or a Web browser by clicking 
on the Export button at the bottom and choosing HTML. If you have provided your 
teams with Custom HTML Codes on the team tabs, the program will ask you if you 
want to substitute those abbreviations for the regular codes being used on the 
screen. I assume you would say “Yes” or there would have been no reason to create 
those codes in the first place.  
 
The report in Excel or browser looks like a calendar. Since this is HTML code, you can 
post the file to a Web site. 
 
That’s all there is to scheduling (in its most basic form). Next, we’ll look at some of 
the most frequently asked questions that I get in the hopes that they will help you 
solve some of your scheduling problems. 
 



- 22 - 
 

Frequently Asked Questions for Diamond Scheduler 

Multiple Copies of the Program 
 
Question: May I put the program on my computer at home and at work, and 
while I’m at it can I also put it on the computer of the league president and 
the field coordinator and  …. 
Yes, you can have the program on up to three computers as long as it directly 
supports the original league for which you bought the program. 
 

Copying the Program to Disk 

Question: I want a “hard copy” of the program in case we need to load it on 
a computer not connected to the Internet. 
You can save the program to either CD or floppy disk to take it to another location. If 
you want to save a copy of the program on CD, the best thing to do is to download 
the installation file and save it to CD. That file is located at 
http://www.cactusware.com/setup.exe. 

Custom HTML Codes 
Question: My league really needs a different abbreviation for calendar view 
than the regular abbreviations. How can I do that? 
If you choose to export to HTML, rather than just print from the program, the full 
team name will be used. In addition, when exporting to HTML in calendar view, you 
can use a custom HTML code (see bottom of the team tab) for each team. If teams 
have a custom HTML code associated with them, you'll be asked if you want to use 
those HTML codes for reports upon export instead of the regular code that is used 
internally by Diamond Scheduler. 
 

Can not Schedule All the Games 

Question: I have plenty of timeslots but the program keeps leaving some 
open and I can’t get all my games scheduled. What’s up with that? 
 
The typical mail message I receive goes something like this: "John, I have six teams 
and when I go to the Tools menu and choose 'Calculate Timeslots Needed,' the 
program tells me I only need 60 timeslots to complete 4 full rounds. I have 80 
timeslots and your program still doesn't make the schedule. What gives? I thought 
this was a good program." 
 
This situation is frustrating for you and me. You, because you think you have enough 
timeslots, and me because sometimes it's difficult to explain the situation .. but 
here’s the most common problem I see: 
 
Typically, when I look at these schedules, there are, in fact, the claimed 80 
timeslots. Unfortunately, they're broken up into 10 timeslots per night on two or 
three fields (it might be 6 per night or 8 per night ... the details vary and the number 
of fields in use may often be more than one). However, even if those timeslots are 
on several fields, it's common that they are concurrent; in the most extreme case, all 
the timeslots are all on one day. To explain, let's say they're all on Saturdays. If you 
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think about this as a little math puzzle, it should quickly become clear what's going 
on.  
 
With six teams, that means only 3 games can occur per night (if teams don't play 
double headers) which means 3 of the timeslots per night are used and 7 of the 10 
timeslots are wasted because all the teams are already occupied. Those timeslots 
might as well not exist! Really.  
 
The basic guideline is you can only use N / 2 timeslots per night where N = number 
of teams. If you have 10 teams, the most timeslots you can use is 5. Any number of 
timeslots beyond that is of no use.  
 
As a consequence, looking at my example (where every team should play 20 games 
per season for a complete 4-round season), only one game per week can be played 
each of the eight weeks and 7x8 timeslots are actually wasted ... they can't be used. 
That means only 24 games can be scheduled. Just like you can't be two places at 
once, teams can't play two games at once to use up the timeslots. 
 
The situation is made worse when there's an uneven number of teams because one 
team typically has to sit out each night. The ideal way to solve the problem is to 
move any timeslots beyond the N / 2 number to a different night and then all the 
timeslots can be used. 
 

Scheduling Multiple Divisions 
Question: You just showed me how to schedule one division in the tutorial. 
However, I have many divisions. How do I schedule those without creating 
time conflicts? 
 
Scheduling multiple divisions with Diamond Scheduler is simple, once you get the 
hang of it. Remember: Each division is scheduled separately from all other divisions. 
In other words, Major Baseball would be one file and Minor Baseball would be 
another file. When you have all your schedules (i.e., files) completed, you merge 
them into what is called a "Combined Schedule Report" to create a Master Schedule 
(select File menu > Merge Schedule Files). 
 
Hint: Make sure you spell the names of fields (venues) and their associated codes 
exactly the same in all files (where they are supposed to refer to the same fields). 
That way, when you merge the files, the fields will be recognized as referring to the 
same locations in both files (the same goes for team names if they're used in more 
than one file as occurs with across-league scheduling). 
 
Obviously, you don’t want to accidentally identify the same timeslots for two 
different divisions. There are two approaches to avoiding this: Identify mutually 
exclusive timeslots or cascade the leftover timeslots. I prefer the first method, 
identifying mutually exclusive timeslots for each of the schedules.  
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Creating the *.SHD Files 
 
Method 1 
As an example, I might identify 5:30 PM on Mondays, 7:00 PM on Wednesdays and 
3:30 PM on Saturdays for the Major Baseball schedule. For Major Softball, I might 
identify 7:30 PM on Mondays, 5:30 PM on Wednesdays, etc. The goal is to have 
mutually exclusive timeslots in each file so, by definition, no two divisions could 
possibly be scheduled at the same time.  
 
There are a couple of tools to help you estimate how many timeslots to reserve for 
any given division (see Tools menu/Calculate Timeslots Needed and Tools 
menu/Calculate Identified Timeslots). One of the biggest advantages of approaching 
the multiple division scheduling by keeping the timeslot independent is that each 
division is isolated from other divisions. If a team is added or dropped from a 
division, it has no effect on other schedules, unlike the second of the two methods - 
cascading the timeslots. However, cascading timeslots can be quite an appropriate 
approach, especially for smaller leagues where re-working all schedules would not be 
a major problem. 
 
Method 2 
By cascading the timeslots I mean that you load all your timeslots into the first 
schedule. You then schedule that first division (generally with some constraints like a 
rest of two days between games and/or a maximum number of games per week in 
conjunction with a maximum number of games per season) so that not all the early 
timeslots are "stolen" by the first division. Once you have this schedule created to 
your liking, you export whatever timeslots are leftover for use in the next schedule.  
 
To export leftover timeslots, you go to the Schedule menu/View Remaining 
Timeslots/Export. This exports the timeslots to an *.shl file. This *.shl file can be 
imported to your next schedule by clicking on the Import Timeslots button of the 
field tab.  
 
Again, my preference is the first method for two reasons: First, if you have a lot of 
timeslots in the first, saturated schedule, it can really slow things down during the 
scheduling of the first few divisions. In fact, there's the potential of running into 
memory problems on your computer if you literally have hundreds of timeslots that 
are not going to be used by that division. So it's not efficient from a time 
management standpoint. 
 
More importantly, since you are cascading the timeslots, i.e., passing along the 
open, leftover timeslots to subsequent schedules, what happens if you add a team to 
the first division? You have to re-do all of your divisions because you now need to 
add more games to the first schedule but all of its leftover timeslots have already 
been given away to another division. The schedules are dependent and this can be a 
real bother.  
 
A Safety Net 
The Exclude Timeslots button on the field tab will let you point to another schedule 
file and double check to make sure you’ve not included any of its timeslots in the 
current file. Of course, for this feature to work, the name of the field and its code 
must be the same in all files. 
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Combining the Divisions 
Once you have all of your individual schedules done, you can create a Combined 
Schedule Report to merge the individual schedules together. To do that, select File 
menu > Merge Schedule Files and follow the directions. 
 

Across-division (or league) Schedules 
Question: I have two divisions, an American League and a National League. 
I want them to play two rounds within their division but also one time 
against the teams in the other division. How do I do this across-division 
scheduling? 
 
Hint: Make sure you spell the names of fields (venues) and their associated codes 
exactly the same in all files where they refer to the same fields so that later on you 
can merge files into a combined schedule report and they'll be recognized as the 
same field (the same goes for team names if they're used in more than one file). The 
same goes for the team names and codes. 
 
There are several approaches.  
 
One approach is to reserve certain days or nights for one division (e.g., Division A 
plays on Mondays at 5:30 PM and Thursdays 7:30 PM and Division B plays on 
Tuesdays 7:30 PM and Wednesdays at 5:30 PM with across-division play on 
Saturday).  
 
Alternatively, in your league, you might set aside two weeks in the middle of the 
schedule for across-league scheduling. That way, you're sure that an intra-division 
game can not be scheduled on the same day as an across-division game. 
  
However, the most common approach is a third one: Schedule the two intra-division 
files then exclude those times from use in the third file which is used to create the 
across-division games. More on that later.  
 
Since the approaches are pretty much the same as far as the files that are created 
(one for each intra-division schedule and then an across-division schedule), I’ll use 
the third method as an example. 
 
First, you need to create the two files that act as the within-division schedule for 
each of the two divisions. In these, teams only play teams within their division (e.g. 
the Monday and Thursday games for Division A). As long as the fields are available 
and not double booked, it's OK for teams to be playing at the same times at different 
fields in these intra-divisions schedules. You create these two files just like you 
would create schedules for two unrelated divisions. Use one of the methods 
mentioned above to make sure you have mutually exclusive timeslots on the fields 
you have available and you should be fine.  
 
Next, given those two intra-division schedule files, you need to create the third, 
across-division games. In the third file, you identify all the teams from both of the 
first two files. 
 
To make it easy to list all the teams, I typically do the following sequence. 
 
 Choose one of the completed intra-division schedules 
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 Choose File/SaveAs Without Timeslots to a different name like 
“acrossgames.shd.” 

 
This saves all the information in the first file (the team names, the fields and the 
division name) into the fresh, third file. All you need now is to add any additional 
teams from the second division and any additional fields used. This is pretty simple: 
 
 On the team tab, click on Import Teams  at the upper right 
 Point to the schedule file for the second division 
 
This will bring in the names and codes for the second division. If you use additional 
fields in the second schedule, which are not identified in the first schedule, repeat 
the process with the fields: 
 
 On the field tab, click on Import Fields at the upper right. 
 Point the schedule file for the second division. 
 
Using this method of bringing in all the team and field info ensures that the names 
and codes are exactly the same in all three files so that they’ll be recognized when 
the schedules are merged.  
 
OK. So now you’ve got a third file with all the teams and venues that you can use. 
You’ll need to identify the timeslots that are available to use. You may have exported 
leftover timeslots if you’re cascading the times. If so, you could bring those timeslots 
in by clicking on the Import Timeslots button of the field tab and pointing to the 
appropriate *.shl file. 
 
Tip: If you have cascaded the timeslots, i.e., you have all your leftover timeslots in 
an external file (an *.shl file), do not bring in the field info ahead of time. In fact, if 
you have fields identified, delete them. The reason is that if you click on the Import 
Timeslots button and you have no fields identified, it will allow you to bring in 
information about all fields and timeslots in the *.shl file automatically. If you have a 
timeslot already identified in the new file, the program thinks you want to bring in 
the leftover timeslots one field at a time. 
 
OK, you have your timeslots ready to go, you’ve identified your home teams for each 
field and there’s only one more thing to do before scheduling this across-division 
portion of the schedule. 
 
 Go to the Team tab. Click on the button that says No-play Times 
 Click on the button that says “Import No Play Times for All Teams from Another 

Schedule” 
 Point to the first team’s intra-division schedule file and click OK. 
 Repeat the process for the second team’s intra-division file and click OK. 
 
You have just told the program, “regardless of what timeslots are identified in this 
schedule file, make sure that under no condition do you schedule a team in this file 
where that team is already scheduled for a game in their intra-division file.” 
 
OK. You’re ready to schedule.  
 
 Click on the Schedule tab. 
 Click on Optimized. 
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 Make whatever adjustments you want for between games and other parameters 
 Click on the checkbox that says Across-league Schedule near the bottom of the 

schedule tab 
 
This takes you to a dialog box where you identify which teams constitute division A 
as opposed to division B so that Diamond Scheduler can do its work in this file by 
only scheduling games across divisions and not within divisions. 
 
 After you identify which teams are division A and B, click the Continue button. 
 Click the Schedule Now button and treat the rest of the process as a typical 

schedule. 
 
Once you complete this inter-division portion of your schedule, you simply combine 
all three files (as described above) into a combined schedule file and your schedule is 
done. 

Across-Division Schedules with Many Divisions 

How Can I Schedule Many Divisions including Intra- and Inter-Division 
Games? 
 
Hint: Make sure you spell the names of fields (venues) and their associated codes 
exactly the same in all files where they refer to the same fields so that later on you 
can merge files into a combined schedule report and they'll be recognized as the 
same field (the same goes for team names if they're used in more than one file). The 
same goes for the team names and codes. 
 
Multiple divisions in across-division mode is a bit ugly, but here's how I'd approach 
it.  
 
Let's say you have 4 divisions (A, B, C, D) and they all play an intra-division 
schedule, plus you want them all to play each other once. 
 
 Schedule the 4 intra-division schedules. I'm hopeful that you have the hang of 

scheduling the regular divisions. Did that go smoothly? If you haven't gotten that 
far, be sure to go through the beginning of this document again. 

 
 With that done, you'll have 4 files with no conflicts on the times (I hope). If you 

want to do a quick check to make sure you don't have any scheduling conflicts so 
far (i.e., you haven't double booked a field), you can go to the File menu > 
Merge Schedule Files. Hopefully, you've spelled the field names the same in all 4 
files so that the program recognizes the fields as the same in each of the four 
files. If there are any potential conflicts, those days will be highlighted in dark 
gray in the Master Calendar of a combined schedule. If there is a day that's in 
dark gray, make sure that there's an appropriate time window being used to 
check for conflicts by clicking on the options tab at the upper left of the Master 
Calendar and setting the time.  

 
 Let's say the intra-division schedules went well. Now, because you have 4 

divisions, you've got to get all the combinations of those four divisions playing 
each other. What I would do is load all the remaining timeslots that can be used 
for the 4 divisions into the first of the across-division schedules you're about to 
create. Then you'll need to create the following files: 
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AB, AC, AD, BC, BD, CD 
 
With all the timeslots in the AB across-division file, follow the directions above for 
scheduling a simple two-division across division schedule (i.e., go to the 
optimized pairings but be sure to click on the checkbox that says “"Across-league 
Scheduling"). Remember, before you schedule, go to the Team tab and click on 
the “No-play Times” button at the lower right, then click on the button that says 
"Import No Play Times for All Teams from Another Schedule."   Sequentially, 
identify the two intra-league files to tell the program NOT to schedule either of 
the teams during times that they already have intra-league games scheduled.  
 
This process will give you your file for the AB league.  

 
 OK. You should have timeslots left over since you put all your available timeslots 

in this file. Go to the Schedule menu, View Remaining Timeslots, Export. This will 
allow you to take the leftover timeslots out to an external file (one that ends in 
*.shl). You’re now done with this file. Save it. 

 
 On to a new file for the AC inter-division scheduling. You can import the team 

names from existing files on the team tab (you should do this so you don't 
misspell team names or codes which would make the program think you're 
dealing with different teams) by clicking on the button at the upper right of the 
team tab that says “Import Teams” (obviously, in this file, you solely point to the 
two existing files - A and C - to get the appropriate team names for this file). To 
import the fields and timeslots that are available, go to the field tab and click on 
Import Timeslots at the bottom. Point to the external file you just created (the 
*.shl file) and import all the remaining timeslots for all the fields.  

 
 On the team tab, click on the No-play Times button and then click on the "Import 

No Play Times for All Teams from Another Schedule" as you did above to make 
sure these teams are not scheduled here for any times they're already scheduled. 
However, be careful. You also need to point to the existing AB file because A has 
some games in there too.  
 
In other words, the guiding principle is that you have to point to any schedule 
files in which either of the two participants of current interest have games. (In a 
four division combination, that means you could have up to 7 files that might be 
included in some match-ups). 
 

 Export the leftover timeslots and repeat the procedure until you have all six of 
the across-division schedules done. 

 
 Go to the File menu, Merge Schedule Files and merge the A, B, C, D, AB, AC, AD, 

BC, BD, and CD files into one Master Calendar. 
 
Hope that makes sense. It's a LOT easier doing it than describing it. 
 

Some Final Words 
No matter how many hints I provide in a document like this, there are always new 
situations and problems to solve. I have tried hard to include tools in Diamond 
Scheduler that allow you to solve the majority of common scheduling problems.  
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If you have other questions or issues that should be addressed in the introduction, 
please let me know by emailing me at jhall@cactusware.com 


